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PRODUCT REVIEW

OmniTrader 2006

ave we arrived at the point
yet when, instead of smiling
in admiration of the old-timer
who still hand-draws his own

For some time, my answer has been
easy: I’m a technical trader, not a com-
puter programmer.

Unfortunately for my ego, a product
like OmniTrader 2006 (OT2006) makes
my “easy” answer harder to abide by.
Unlike a lot of automated trading plat-
forms available on the market, it ap-
pears as if OmniTrader 2006 has put a
premium on not just effectiveness, but
simplicity as well. There is precious
little complicated code to learn or algo-
rithms to wade through, and the
software’s “Getting Started” mini-
manual is almost suspiciously straight-
forward and easy to understand.

True, there are some sacrifices for
simplicity’s sake, and some of the more
complicated trading systems that a trader
might want to construct might be better
served with an even more complex (and
more expensive) software product. But
for average (and somewhat above-aver-
age) traders willing to leave their egos at
the trading room door, OmniTrader 2006
provides an opportunity in trading auto-
mation that must be considered by any
trader still mired in fool’s gold that dis-
cretionary trading often turns out to be.

H

ALL-AROUND OMNITRADER
The main workspace of OmniTrader
2006 is refreshingly uncluttered (Fig-
ure 1). A short toolbar across the top, a
series of buttons and pulldown menus
across the top below the toolbar, a set of
buttons down the right side of the
workspace, and a set of pulldown menus
and buttons across the bottom pretty
much take care of all the adornment.
The top toolbar consists of standard
file-creating, opening, saving and print-
ing functions under the File menu. The
Edit menu contains more variety, in-
cluding options to change data settings
(for example, datafeed source, pass-
word, and so on), pattern settings (for
example, length of trendlines, support
and resistance lines, toggle candlesticks
on/off, and more), or call up one of 10
different preloaded trading strategy
methods. There are also options to ad-
just data periods, exchange informa-
tion, or holiday information.

The Mode menu lets traders use
OmniTrader 2006 in one of four differ-
ent ways: “real,” “game,” “lab,” or
“auto” (more on this later). The Tools
menu contains some maintenance fea-
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point & figure charts each evening, we
can finally just say something to the
effect of “Wow, so that’s what you old
dudes did before OmniTrader?”

I’m no graybeard. And I don’t con-
sider myself a discretionary trader, ei-
ther. I’ve got a system (or two), rules,
even a sound money management pro-
gram. I also have stacks of yellow legal
pads, skinny spiral notebooks, fat ma-
nila folders and more Post-it notes than
a strip mall with a Staples at one end and
an Office Depot at the other, just to keep
track of my “system(s).”

Why, you might ask, do I go through
all that paperwork to keep track of a
system that could in all likelihood run
by itself? Why not automate the pro-
cess, save myself some time, and cut
back on the inadvertent deforestation
program that the reams of paper I plow
through have come to represent?

FIGURE 1: OMNITRADER 2006 WORKSPACE. Here’s the workspace in Omnitrader with the focus list and swing
template in the price chart.
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tures such as “repairing” the database,
or restoring original default settings.
Those new to OmniTrader can also use
the Tools menu to find a short introduc-
tion to the software. The Window menu
has options that traders can use to ar-
range the various windows within the
workspace (tiling horizontally or verti-
cally, and so forth). And finally, the
Help pulldown menu is where traders
can go for information about the soft-
ware itself (the Quick Start, OmniScan,
and the user guide can all be accessed
from this menu), as well as about devel-
oper Nirvana Systems itself.

The Help menu also provides a handy
guide to the indicators and systems used
by OmniTrader 2006. This is a solid
reference for those who want (or need)
to learn more about the indicators and
trading systems available through
OT2006. The number of indicators that
can be used is thoroughly overwhelm-
ing—there’s no other way to describe
them—and almost certainly covers the
gamut of technical tools that 99% of the
technical traders out there are likely to
be on the lookout for.

Below this set of pulldown menus are
some basic functions that traders oper-
ating OmniTrader 2006 will use with
some frequency. These include buttons
to access the focus list and to-do list, and
a “chart options” button in order to
make changes to the charts in terms of
appearance, indicators, trading strate-
gies applied to it, and so on.

Next to the chart options is a quick
chart window in which traders can enter
in a symbol and call up a chart of a
security. Traders can change the “strat-
egy view” with a pulldown window
located to the right. Beside that are
options to edit the selected strategy, edit
pattern settings, and order buttons (en-
ter long, enter short, close open posi-
tion) for simulated trading purposes.
Appropriately, next to that set of but-
tons are options to “view order notifica-
tions” and to view the portfolio.

The focus list (Figure 2), I should
mention, is where a lot of the action is in
OT2006. It is the easiest way to view
results of strategy scans and it serves as
a sort of power watchlist into which
traders can store information about all
the stocks that OT2006 will survey. By
way of default, the focus list starts with

columns for the symbol of the security,
the trading signal provided by the se-
lected trading strategy (more on these
signals later), the ADV (advisor) rank-
ing that indicates how strong the trading
signal is, the name of the strategy used,
backtest hit rate, backtest APR, and
backtest long positions and shorts. The
focus list is significantly configurable
and traders can use the configure col-
umns feature in order to add and remove
the data columns most relevant to them.

In addition, the focus list can be sorted
(including multiple sorts) based on any
of the rankings within a given data col-
umn. So if a trader wants to rank the
results of a scan by backtest hit rate or
ADV, OmniTrader 2006 makes it easy
to do so with the list’s sort function.
There are a number of ways to enter
symbols into the focus list: directly
through the add symbol feature, by way
of the symbols database, by way of the
import function (ideal for ASCII symbol
lists), and simply copying and pasting
from an OT2006 profile. Traders can
also add alerts to the symbols on the
focus list and call up a chart directly.

The focus list module, which can be
detached from the OmniTrader 2006
workspace, has a few feature keys in a
pair of mini-toolbars above and below
the set of columns. These keys—across
the top—allow traders to add a chart, edit
the focus list, find a symbol, sort, show
positions, configure the focus list, and
filter signals based on both accuracy and
frequency. In the bottom toolbar are op-
tions to activate the watchlist, notes, sta-
tistics for the focus list, and charts.

I mentioned the signals column.
OmniTrader 2006 uses eight different
symbols to indicate trades. New longs
and new shorts each have their own
symbol (green and red, respectively), as
do “reinforced” long positions and
shorts, in which OT2006 was already in
the trade based on one trading system
and received an additional signal in the
same direction from another system.
Green and red arrows indicate trades in
process, while a green square repre-
sents an OT2006 exit. A black dash
indicates no trades for the specific pe-
riod, and the absence of a symbol means
simply that OmniTrader is not in a trade
for that particular tradable.

BACK TO THE WORKSPACE …
Along the right side of the workspace
are a number of additional buttons, most
of which are related to drawing and
drawing tools. There are tools to toggle
the drawing tools on or off, to create
trendlines, rays, and segments as well
as support & resistance lines. Traders
using OmniTrader 2006 can even create
trendlines with alerts—a feature I’ve seen
in more and more software packages
lately. Fibonacci retracements can be
added, as can text, and traders can plot
trading signals on the charts as well with
the tools in this part of the workspace.
Across the bottom of the workspace are
options to change the chart date, edit
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FIGURE 2: FOCUS LIST. The focus list serves as a
sort of super-watchlist in which symbols to be ana-
lyzed by OmniTrader are noted. Here, also, traders
can see what signals are available for different sym-
bols and the advisor rating for those signals as well as
the name of the strategy being used.
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chart periods, establish periodicity (daily/
weekly), and edit chart periods (three,
six, nine, 12, or all months).

Within the charting window itself are
a few more pulldown menus and fea-
tures worth mentioning. These include
a template menu to allow traders to
switch quickly from, say, a “reversal”
template with indicators geared toward
reversal strategies, to a “trending” tem-
plate with indicators geared toward
trending strategies. Periodicity controls
can also be found here, as can a feature
that lets traders see charts of the sector,
group, or subgroup that a particular
stock is in. For example, if I have “F”
(for Ford Motor) as my opened chart,
and I click on “Symbol,” then “Sector,”
then a chart of the consumer goods
sector will pop up.

Changing to “Group” brings up a chart
of the “Automotive” group, and so on.
Finally, along the bottom is the trading
system vote bar (Figure 3). The vote bar
gives traders a quick look at whether the
market in question is in a long, short, or
no-trading mode based on the trading
system applied to the chart.

I’ve long been a fan of using trading
systems the way most people use indi-
cators. I like to be able to look at a
market and say, “Well, two of my three
systems are on buy signals in XYZ

stock,” rather than just parsing another
technical indicator. OmniTrader’s vote
& signal lines perform a similar func-
tion. The signal lines each note an entry
and exit for a specific strategy, with a
line between the two indicating the du-
ration of the trade. The vote lines, which
are located just above the signal lines at
the bottom of the price chart, represent
a distillation of the signals generated by
the signal lines. Incidentally, the way
the vote lines come to this is also an
adjustable feature of OmniTrader 2006.

OMNICHARTS
OmniTrader 2006 features charts that
are more configurable and easier to
read than most that accompany auto-
mated trading systems. For too many
makers of automated trading software,
it seems as if an attitude has been adopted
that says, “Hey, you’re getting the sig-
nals you need to trade, what do you
need to look at a chart for?”

OT2006 is not among those who have

taken that approach to charting. This
software comes with an incredible
amount and variety of indicators, as
well as a number of drawing tools, in-
cluding trendlines with alerts. More than
one chart can be opened at a time for
quick comparison analysis, and traders
can actually plot trade signal entries and
exits on a chart. The number of stop/exit
options is impressive, ranging from
breakeven and fixed-profit stops to trade
session boundary stops, trailing profit,
and trailing pivot-point stops.

Most of the features that chartists have
come to depend on have been retained
for OmniTrader 2006. These include data
windows and cursors, adjustable data
ranges, and chart areas. Both periodicity
and scale are also adjustable, and OT2006
also allows traders to “synch” different
charts with different periodicities —
comparing the daily and weekly views
of a given security, for example. Charts
can be customized by changing the col-
ors, including everything from back-
ground color to text to up bars vs. down
bars, and more. Pivot points can be added
and plotted, and for those old-timers who
remember the days when a fat envelope
arrived in the mail on Saturday morning
loaded with the charts of the previous
few days, OT2006 provides a chartbook
function that lets traders create their own
printable chartbooks of securities they
want to keep track of.

One last aspect of OmniTrader 2006’s

charts worth mentioning is their tem-
plates. The software comes with its own
small chart templates, but traders who
become comfortable with them can cre-
ate several more. The standard templates
that come preset include a trending chart
template, which comes equipped with
three exponential moving averages, and
three, trend-oriented indicators: Bull
Power, Bear Power, and the Trend Inten-
sity Index. The reversal chart template,
which is geared toward catching trend
changes, comes with two indicators: the
moving average convergence/divergence
histogram (MACDH) and the momentum
indicator. OT2006 recommends that the
swing chart template be used along with
the reversal chart template, insofar as
both sets of indicators are geared toward
catching shifts and changes from recent
trading behavior. The swing chart tem-
plate uses the relative strength index (RSI)
and the MACDH. A standard template
comes with volume alone.

STRATEGIES OF THE TRADE
OmniTrader 2006 groups its trading strat-
egies into six different categories, each
designed to exploit a different type of
market condition. Beyond the default
strategies, which are quite broad and uti-
lize a market’s specific trading history in
order to uncover trading opportunities to
the long and short, trend and countertrend
sides, OT2006 has two classes of trend-
ing markets strategies called “seven-day

FIGURE 3: VOTE & SIGNAL LINES. At the bottom of the price chart, the vote & signal lines give traders an at-
a-glance sense of how many and what kinds of systems are contributing to the final “vote” to go long, go short,
or remain on the sidelines.
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moves” and, appropriately enough,
“trending strategy.” The latter class of
systems, according to OmniTrader 2006,
is specifically helpful with spotting short-
and medium-term opportunities and uti-
lizes a 40-period exponential moving av-
erage to screen out countertrend trades.

The other three classes of trading sys-
tems available through OT2006 cover
methods and approaches that most dis-
cretionary and systems traders have
grappled with. These classes include
“diverge,” which uses divergence-based
systems to spot reversal opportunities.
As anybody who’s spent any time at all
trying to catch tops and bottoms with
divergence-based systems and methods
can tell you, these systems have a ten-
dency to be “early” (read: short-term
pain before longer-term gain), and
OmniTrader 2006 itself recommends that
traders rely on additional confirmation
with these types of trades.

Another class of strategies is the swing
set that tends to replicate those sorts of
trading opportunities sought out by short-
term, swing traders. For OmniTrader
2006, there is a volatility kicker that is
sought out as well, giving traders the
opportunity to profit from phenomena
such as low-volume pullback during
market moves. See Figure 4.

And speaking of pullbacks, the last
class of trading system offered by
OmniTrader is called “breakout.” As
you might imagine, breakout systems
and strategies involve markets that are
moving up or down from consolidation
ranges, bases, and patterns. These meth-
ods include breakouts that lead to new
trends as well as those that serve to
reignite old trends.

An entire article could probably be
written about OmniTrader 2006’s ap-
proach to building trading strategies.
While I suspect that many, if not most,
of those traders who purchase and use
OT2006 won’t need to get too far under
the hood to see what makes the software
run, the software nevertheless makes
that exploration seem fairly straightfor-
ward, if not simple, for those inclined to
break down their favorite trading strat-
egy block by block.

I use the term “block” specifically
because that is how OmniTrader 2006
organizes the various commands that
make up its various trading strategies.

This flow-chart ap-
proach makes the
strategies surpris-
ingly easy to com-
prehend compared
with the program-
ming code used to
describe most trad-
ing strategies. The
flow-chart ap-
proach also makes
the strategies that
much easier to
modify, with a set
of rules governing
which type of com-
mand block must
follow the other,
and how the trader
must “reset” the database for the changes
in given strategy to take effect. Those
not interested or able to create a trading
strategy from scratch can build their
own based on the template of one of the
strategies already provided by OT2006.

In addition to creating strategies, trad-
ers using OmniTrader 2006 can increase
the specialization of their strategies by
adding “special condition” filters. These
filters can be as simple as controlling
for volume or volatility increases or as
complex as an entire slew of indicators
whose reading will only be considered
if a certain set of market conditions
develops. In addition, the filters can be
optimized for a particular strategy. A
formula builder tool makes it easy for
traders to build their own filters from
scratch, using straightforward opera-
tors, parameters, symbols, and so on to
create a coherent formula that will serve
as what OT2006 calls a “programmable
filter” for deployment alongside your
trading strategies. The software even
has a criteria rule library that matches
the commonsensical name for a given
criteria (for example, momentum in-
creasing) into the appropriate “com-
puter-readable” criteria text.

OmniTrader 2006 also features some-
thing called “trade plans,” which makes
it easier for traders to manage their trades.
Trade plans take the trader from the
initial order through whatever money or
trade management rules have been se-
lected. OmniTrader 2006 provides seven
different trade plans that traders can use
or modify: a default fixed-loss stop,

eighths stop, eighths stop-partial exit,
long-term trending, medium-term trend-
ing, partial exit, and short-term trending.

All of these use the average true range
(ATR) as a key ingredient in determin-
ing stop-loss levels (a hint to those who
do not factor in the range, either by ATR

or some other method, when doing post-
order trade management). Adding and
editing conditions to the trade plan is
simple and straightforward—here, as else-
where, eschewing formula language, and
instead relying on pulldown menus and
clickable lists to help traders find and/or
create the conditions they are looking for.

OmniTrader 2006 also comes with a
fairly comprehensive portfolio feature
that allows traders to track their trades.
The software also comes with the abil-
ity to run trade simulations in two modes,
game and lab. In game mode,
OmniTrader 2006 picks a security from
the focus list and, without revealing the
name of the tradable, displays the chart
along with trendlines, patterns, and those
technical strategies that will best track
the mystery security. Moving one day at
a time, traders in game mode can decide
to buy or sell, cover short positions, or
close out longs, while the software tracks
profit & loss in the OmniTrader portfo-
lio. Features such as stop-losses are also
available to traders in game mode.

Lab mode is very similar to the simu-
lation in game mode, with the key differ-
ence that the lab mode simulation has
traders manage a portfolio of up to 10
securities rather than just one. As with
the game mode, all of the main features

FIGURE 4: ASSISTANT. Clicking on an individual strategy in the vote & signal lines
area will create a pop-up assistant like this one, which explains the system, its
parameters, and performance.
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of OmniTrader are available during the
simulation, though some functions are
automated in order to streamline the pro-
cess. In all, both modes are excellent
ways not just for traders to learn about
the world of trading, but also for traders
switching to OmniTrader 2006 from other
platforms to get to know some of the ins
and outs of OT2006 before they begin to
commit real capital to the process.

OMNITRADER OUT!
There are other aspects of OmniTrader
I have not covered that traders nonethe-
less may come to appreciate. These as-
pects include a reports feature that lets
traders read, save, and print reports on
signals, strategies, symbols, and portfo-
lios. Performance summary reports not-
ing such information as the number of
trades, number of profitable trades, av-
erage hit rate, average bars per trade,
and much more are available, as are
detail reports that include information
average; highest and lowest profit; num-
ber of consecutive wins; worst draw-
down, and so on. OmniTrader comes as
an end-of-day package as well as a real-
time package and is available for fu-
tures as well as for stocks.

As is suggested in its literature,
OmniTrader 2006 exists in a world be-
tween “discretionary–toolkit–technical”
trading and black-box trading. There is
nothing wrong with either approach, of
course. Numerous traders have success-

fully traded the markets using little more
than support & resistance lines,
trendlines, and moving averages or, con-
versely, using their own strange brew of
esoteric indicators. And certainly thou-
sands have benefited from black-box
systems that, at the risk of sounding
cynical, tell traders specifically “when to
hold ’em and when to fold ’em” without
cluttering their minds with “Why?”

But my suspicion is that for most
people who aspire to be traders, the
ideal method lies — as OmniTrader
does — between these extremes. Dis-
cretionary trading, in addition to requir-
ing skill and/or knowledge, also requires
a discipline that most people simply
can’t sustain trade-in and trade-out. This
is no crime. After all, human beings are
creative and complex individuals. But
sometimes, that creativity and complex-
ity gets in the way of training oneself to
do the same thing the same way at each
opportunity—which is precisely what
successful trading tends to boil down to.
On the other hand, black-box trading
leaves many of these “creative and com-
plex individuals” cold.

On occasion, I wonder how aspiring
traders would respond if a genie ap-
peared and said: “I’ll give you two
choices. You can spend your time ana-
lyzing, sorting, scanning, screening, and
trading, and you can make or lose what
you will. Or you could forgo all that
work and I’ll just FedEx you a check —
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or a bill — every month for the exact
same amounts you would have made —
or lost — trading.”

My suspicion is that most aspiring
traders — rightfully or wrongfully —
would not take the genie up on the latter
offer. To me, that defines the dilemma
of the black-box approach to trading.
Most traders want to get their hands
dirty, to look under the hood, to get out
on some open road, and put the thing
through its paces—even if it means more
work, even if it means less profit at the
end of the day.

Fortunately, OmniTrader 2006 rep-
resents a path that manages to skirt both
“more work” and “less profit.” With the
ability to scale from the most basic
trading strategy application to more
complex formula-building, OmniTrader
2006 provides a great deal for a variety
of traders. Even those wedded to a more
discretionary style of trading can take
advantage of OmniTrader’s array of
technical indicators and excellent draw-
ing tools, perhaps even using the
software’s various trading strategies as
confirmation or even just a second opin-
ion on opportunities uncovered by Dow
theory, Elliott wave analysis, cycles
analysis, or even just plain old-fash-
ioned support & resistance, trendline
technical analysis.

David Penn is the Technical Writer for
STOCKS & COMMODITIES.

http://www.traders.com/

